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Chat Activity 
The Moodle chat tool allows communication between instructors and students in real time. Unlike in discussion 
forums, which are a means for asynchronous communication, online chat sessions need everyone to be logged 
in at the same time in order to communicate. 

Creating Chats 

1.  Click the  button 

2. Click on the Add an activity… drop-down menu in the 
specific module and select Chat   

3. In the adding a new chat page, give the chat room a 
Name and provide directions on how to use the room in 
the Introduction text box   

4. Set the time for the initial chat session in Next chat time. 
This will create an event in your calendar 

5. The Repeat sessions options available for a chat 
session are as follows:  

 Don’t publish any chat times: Creates a chat room 
that is available to students at anytime 

 No repeats - publish the specified time only: Creates 
a one-time only chat room that will only be available 
during the time specified 

 At the same time every day: Creates a daily chat 
session available to students at the time specified 

 At the same time every week: Creates a weekly chat 
session available to students at the time specified 

6. You may choose to save transcripts of chat sessions for 
the amount of time specified under Save past sessions 
option. Choose the amount of days the transcripts are 
saved or choose Never delete messages   

7. You may further set whether the transcripts are available 
to students or just to the instructor under the Everyone 
can view past sessions option   

8. Click                                       at the bottom of the page 
once you have completed choosing the chat settings  
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How to Participate in a Chat Session 

1. Access the course that you are scheduled to 
have a chat session in by clicking the 
appropriate course link 

2. Press                                                to enter 
the chat room  

3. A new window with the chat session will open  

4. Type in the space at the bottom of 
the page and click Send to enter 
your responses   

5. To change the display, click on 
Themes and choose from Compact 
(default) or Bubble  

6. To engage in a dialogue directly 
with a student, click Talk beneath 
their name and type your message 
(Note: All messages sent under 
Talk can still be viewed by the 
other participants)  

7. To exit the chat session, close the 
window by clicking the              icon 
on the upper right of the chat 
window 

 

  

Participants currently in 
session

Type your text here and 
press enter to send it. 
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Wiki Activity 
What is a Wiki? 

A wiki is an activity for collaborative work. A wiki page is a document everyone in your class can expand and 
edit. It is an effective method of compiling information on a specific subject quickly as a group. 

Note: Wikis cannot be edited by more than one person at a given time. Moodle will not allow simultaneous 
access to edit a wiki. 

Creating a Wiki 

1. Log in to your course and click   

2. Click on the Add an Activity… drop-down menu in 
the specific module and select Wiki   

3. Type in a Wiki name   

4. Type in a descriptive summary under Description for 
your wiki explaining to your students what you expect 
them to work on and achieve within the wiki 

5. Title the first page of your wiki under First page  
name  

6. For the Wiki mode, select either Collaborative wiki 
or Individual wiki.  The wiki mode determines 
whether everyone can edit the wiki - a collaborative 
wiki - or whether everyone has their own wiki which 
only they can edit - an individual wiki. 

Note: You cannot use Groups in an Individual wiki.  

7. The Default format should be set to HTML  

8. Click on                                   .    .  

 

 

How to Edit an Existing Wiki 

1. Click on the link of the Wiki to be edited 

2. Click on the Edit tab   

3. Make any changes to the Wiki and click Save 

Note: It is good practice to always preview changes 
that you have made before saving them. 
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Adding a New Page 

1. Click on the link of the Wiki to be edited 

2. Click on the Edit Tab  

3. To add a new page, in the text box place the 
title of the new page in double brackets (e.g.,  
[[new page]]) 

4. Click  at the bottom of the page  

5. To edit the contents of the new page, click 
on the link to the page in the View tab  

6. Title the page and confirm that the format is 

set to HTML. Then click  

7. Add text and additional links on the Editing 
page for your new page 

 

More Wiki Options 

 The Comments tab allows the users to add comments about the 
wiki page 

 The Map tab lists all of the pages that have been created in the wiki 

 The Files tab allows users to attach files to the wiki page 

 The History tab allows you to view user activity within the wiki 

 The Administration Tab allows you to remove pages 

 For Wiki pages, scroll down to the Tags section of the Edit page to 
add key words to categorize wiki postings 
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Groups 
The Groups feature in Moodle lets an instructor create student groups for activities. Students can be divided 
into groups for activities that allow them to work more closely together. In Moodle, you can specify which 
activities use group mode. 

Creating a Group 

1. Click on the                    icon in the Administration block 
under Users  

2. Click on the Create group button at the bottom of the left 
column   

3. Enter a descriptive Group name  

4. Click on                        

Note: The group name will now show up in the middle column 
with a zero next to it identifying there are no current members in 
the group. After creating the group, the next step is to add 
students to the group.  

Adding Users to a Group 

1. Click on the                    icon in the Administration block 
under Users 

2. In the left column, click on the name of the group  

3. Click on the Add/remove users button at the bottom of the 
right column 

4. On the Add/remove users page there will be two columns. In 
the left column are existing users in the group; in the right 
column there are users in the course that can be added to 
the group. Select the names of the students you wish to add 
to the group from the right side  

5. To add the selection to the desired group, click on the     
button in the center 

Note: Students will now show up in the right-hand column and from 
there you can remove them at a later point in time. 
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Using Groups: Separate and Visible Groups 

When activities are created, group options are present. This section will explain the standard set of options 
regarding groups at activity creation.  

1. The Group Mode drop-down menu has three options:   

 No groups – activity doesn’t designate by group 

 Separate groups - each group can only see their own group, 
others are invisible 

 Visible groups - each group works in their own group, but can 
also see other groups   

Removing Users from a Group 

1. Click on the                     icon in the Administration block 
under Users 

2. In the left column, click on the name of the group  

3. Click on the Add/remove users button at the bottom of the 
right column 

4. On the Add/remove users page there will be two columns. 
Select the names of the students you wish to remove from the 
group on the left side list  

5. To remove the selection from the desired group, click on the                 
button in the center   

Removing a Group 

You can quickly remove a group as follows: 

1. Click on the                    icon in the Administration block 
under Users 

2. In the left column select the group you wish to remove   

3. Click on the button under it labeled Delete selected group   

Note: Removing a group does not delete the members in it. It only 
removes their membership. 
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Calendar Block 
The calendar shows events that are happening in your classroom. Events are added to the calendar, and can 
be for individual users, for your defined groups, or for the whole course. Online assignments in Moodle will be 
automatically added to the calendar. If closing dates are set in assignments, forums, quizzes, etc., these will 
also show up on the calendar.  

Navigating the Calendar  

You can view previous or future months by clicking on the left or right 
arrows next to the current month’s name.  

Clicking on the current month brings you to the calendar main page 
where you can add and modify events.  

The days with events in your calendar will be color-coded. Today’s 
date will always be outlined with black borders. Hovering with the 
mouse over a particular date brings a dialog with the event’s name.  

Under the Events key, the four eye icons let you hide/show events of 
certain type for more convenient use. This influences only your 
account and does not change what the students will see.   

 
Adding an Event 

All dated online assignments and activities will automatically be added to your calendar. To add an offline 
activity, personal, or group event you would have to add it manually: 

1. Log into Moodle and access the course you want to 
add a calendar event to 

2. In the Calendar block click on the name of the month 
shown to enter the calendar window   

3. Click on                     at the top right-hand corner of 
the calendar window  

4. Select the Type of event   

5. Give an Event title (mandatory) and short 
Description of the event (optional) 

6. Choose the date and time the event takes place and, 
if desired, open the Duration tab to select the duration 
of the event and the number of times it will repeat  

7. Click on                    .  .  
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Modifying an Event 

To modify a previously created event:  

1. Log into Moodle and access your course  

2. Click on the name of the month that your event is 
taking place in  

3. Click on the day your event is taking place   

4. Click on (the Edit icon) next to the event’s name  

Note: If the item you wish to edit is an online assignment or activity, you 
would be taken to the respective item’s editing page. For example, if you 
click on edit for a quiz, you would be taken to the main quiz editing 
window from which you would be able to change not only the date, but 
also all the other elements of the quiz.  

Note: If the event is a user or group event, you would be taken to the 
same screen you see when you create an event. There you can simply 
edit your event and click on Save Changes.  

 
Hiding and Showing Events 

To help you with viewing the calendar, Moodle lets you 
hide/show events for each of the four main types. To 
hide/show an event: 

1. Log into Moodle and access the course you want to 
view the calendar for 

2. Right under the calendar click on the name of the 
event type you wish to hide/show. The eye icon next 
to it will immediately change  
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Scheduler 
Moodle Scheduler is an activity that enables professors to post their available timeslots to arrange meetings 
with students. Students are able to select a timeslot that best suits their schedule and make an appointment. 

Creating a Scheduler 

1. Log in to your course and click  

2. Click on the Add an Activity drop-down menu in the specific 
module and select Scheduler  

3. Name the scheduler in the Name field  

4. Provide a clear explanation of the scheduler to your students in 
the Introduction box  

5. Next to Mode, choose either Students can only register one 
appointment (your students can only choose to make one 
appointment), or Students can only register one appointment at 
a time (students can make more than one appointment)  

6. Enter approximately how long each meeting will last in minutes 
in the Default Slot Duration box. This will be a significant factor 
when you set up slots for your students to sign up to make an 
appointment  

7. Click on 

 

Setting up Time Slots for Meetings 

Click on the Schedule that has just been created.  A new page will appear where you will set up different time 
slots for you to meet with your students. 

1. Click Add Slots, then + Add repeated slots 

2. Set Date to the first day meetings begin, Enable the Repeat 
Time Slot Until date, and set to the final day of meetings   

3. Under Add Appointments on, check the days that meeting 
slots should be created on   

4. Specify the Start time and the End time. The time between 
will be broken into multiple slots automatically  

5. Set Allow multiple students per slot? to specify how many 
students can schedule per slot time  

6. In the Location box type the meeting location 

7. From the Teacher drop-down select who is holding the 
appointment  

8. Divide into slots? should be yes. Specify the Duration of 
each meeting (i.e., how long each meeting slot will last)  

9. Click  
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Utilizing the Scheduler 

When you click on your scheduler, it will appear to the instructor as shown below.    

1. To Add slots:  

To add many slots, click Add slots, then  
+ Add repeated slots 

To add one time slot at a time, click Add 
slots, then + Add single slot 

2. To Delete slots:  

 Selected – Check the left column box 
for the slot(s) you wish to delete, then 
click Delete slots, then x Delete 
selected slots 

 Unused – Click Delete slots, then        
x Delete my unused slots 

 All – Click Delete slots, then x Delete 
all my slots 

3. Action Icons: These icons will help you edit meetings 

 Will delete the slot 
 Will allow you to edit details of the slot, including duration 
 Will change meetings from individual to group sessions 

  

Scheduler through a Student Perspective 

1. Students see all available slots in one 
page. If they are signed up for a 
specific slot, it will be bolded and say 
Booked under Group Session  

2. Otherwise they can select their 
Choice, and click Save my Cho to 
schedule a meeting 

Note: When your students schedule a meeting to see you, or cancel a meeting, you will receive a notification email. 

Assigning Students to a Slot/Appointment 

1. Scroll down to the bottom of the scheduler until you see 
Schedule by student. Click Schedule, then Schedule 
in slot next to their name under the Action column   

2. Choose the Existing time slot and this will fill in the 
remainder of the options (unless you want to change 
something specific). After you have verified that 
everything is filled in correctly scroll down and click Save 
Changes 

Notes: When you are scheduling appointments using this technique, it is important to notify your student that you 
have scheduled an appointment to see them, either by email or when you see them face to face. 

Select Schedule - Mark as seen now if you have already seen the student and would like to document it. 
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Different Views 

1. My Appointments view: This is the default view, and 
when you open up scheduler, you will automatically see 
the scheduler in this view. This view is optimized for 
creating slots for students to book appointments to meet 
with you  

2. Overview: This will allow you to have an overview on the 
schedules you have made with your students in the past, 
along with when and where it took place, as well as other 
important information. This view is recommended to obtain 
an overall look on the appointments that you have held with 
your students  

Additional Options 

1. Statistics:  This displays the total amount of students who 
can potentially attend a meeting, who have not attended a 
meeting, and the number of available slots remaining 

2. Exports: This allows you to export the scheduler to Excel, 
OpenDoc or CVS   


